
MAXREFDES117#: HEART-RATE AND PULSE-OXIMETRY 
MONITOR 
 

The MAXREFDES117# reference design is a low power, optical heart-rate module complete 
with integrated red and IR LEDs, and a power supply. This tiny board, perfect for wearable 
projects, may be placed on a finger or earlobe to accurately detect heart rate. This versatile 
module works with both Arduino and mbed platforms for quick testing, development and 
system integration. A basic, open-source heart-rate and SpO2 algorithm is included in the 
example firmware. 

The board features 8 sewing tap pads for attachment and quick electrical connection to a 
development platform. 

As with all Maxim reference designs, the BOM, schematics, layout files, and Gerber files are 
all available from the Design Resources tab. In addition, boards are available for purchase. 

Features 

• Optical Heart-Rate Monitor and Pulse Oximetry Solution 
• Tiny 12.7mm x 12.7mm (0.5in x 0.5in) Board Size 
• Low Power 
• Device Drivers 
• Free Algorithm 
• Example C Source Code For Arduino And mbed Platforms 
• Test Data 

Competitive Advantages 

• Highly-integrated, small-size sensor 
• Non-chest based heart-rate/SpO2 detection 
• Ultra-low power consumption 

Applications 

• Wearables 
• Heart-rate monitor 
• Pulse oximeter 

 

 

 

 



MAXREFDES117# System Board  
 

 

Introduction 
Wearable devices hold the potential to transform health and medical monitoring. Heart rate, 

specifically, provides tremendous insight into heart function and health, during both activity 

and rest. Innovation and development of both optical semiconductors and lower-power 

integrated circuits makes the transition to wearables possible. Until now, only large 

organizations, with deep development budgets, could deliver such advanced products. 

MAXREFDES117# delivers the promise of wearable devices to all developers. This unique 

design measures both heart rate and pulse oximetry. MAXREFDES117# features the 

MAX30102 with integrated red and IR LEDs for heart-rate and SpO2 detection. This 

configuration ideally detects heart rate and pulse ox on a person’s fingertip, earlobe, or other 

fleshy extremity. The small board size of 12.7mm x 12.7mm (0.5in x 0.5in) is ideal for 

wearable applications and may be stitched into fabric for immediate prototyping. Firmware is 

available for both Arduino and mbed platforms, enabling users to develop with virtually any 

platform. User needs to provide a 2V to 5.5V supply at the power input, perfect for virtually 

any battery or Arduino and mbed form-factor board. 

The MAXREFDES117# design utilizes the heart-rate/SpO2 sensor (MAX30102), an efficient, 

low-power step-down converter (MAX1921), and an accurate level translator (MAX14595). 

The entire design typically operates at less than 5.5mW when using with the example 

firmware. A block diagram of the system is shown in Figure 1. 

 



System Diagram 

Figure 1. MAXREFDES98# reference design block diagram. 

The power requirement is shown in Table 1. 

Table 1. Power Requirement for the MAXREFDES117# Reference 
Design 

Input Voltage (V) Input Current 
(mA, typ) 

2V to 5.5V 1.5mA (3.3V input) 

Note: Controller board is powered separately 

The MAXREFDES117# reference design is a PPG-based heart-rate and SpO2 monitor 

subsystem. The circuit utilizes the MAX30102 heart-rate/SpO2 sensor with integrated red 

and IR LEDs. The step-down converter MAX1921 converts the 2V to 5.5V supply input and 

generates the 1.8V rail for the heart-rate sensor. The MAX14595 level translator provides an 

interface between the heart-rate/SpO2 sensor and the controller board, which generally use 

a different logic level. 



Detailed Description of Firmware 
The MAXREFDES117# can be used with virtually any microcontroller that has I2C interface. 

The Arduino and mbed example firmware have been tested on the following development 

platforms: 

mbed: 

• Maxim Integrated MAX32600MBED# 

• Freescale FRDM-K64F 

• Freescale FRDM-KL25Z 

Arduino: 

• Adafruit Flora 

• Lilypad USB 

• Arduino UNO 

Users may read sampled data, calculated heart rate and SpO2 through a terminal program, 

allowing analysis on excel or any third-party software. The simple process flow is shown 

in Figure 2.  

 

Figure 2. The MAXREFDES117# firmware flowchart. 



The complete source code, including the heart rateheart-rate/SpO2algorithm, is provided to 

accelerate development. Code documentation can be found in the corresponding firmware 

platform files. 

Heart rateHeart-rate accuracy varies depending on the chosen platform. The tested mbed 

platforms give more accurate heart-rate/SpO2 calculations than the tested Arduino platforms 

because the mbed platform controllers have more SRAM than the Arduino platform 

controllers. For the example firmware, mbed platforms store 5 seconds of samples collected 

at 100sps, while the Arduino platforms store 4 seconds of samples collected at 25sps. 

SpO2 calculation is based on the equation shown below. However, determining the 

constants (C1, C2, and C3) requires a comprehensive clinical study of pulse pulse-oximetry 

data from a statistically significant population set using this hardware. Such a clinical study is 

beyond scope of this design. Therefore, the calculated SpO2 value may havecan have an 

error. 

SpO2 = C1 × AverageRatio2 + C2 × AverageRation + C3 

Where AverageRatio is the average ratio of IR and red LED readings. C1, C2, and C3 are 

constants. 

Quick Start 
Required equipment: 

• Windows PC with a USB port 

• MAXREFDES117# board 

• 5 cables that can be used to connect the MAXREFDES117# with the controller board 

• One of the supported mbed or Arduino controller boards listed above 

• One USB cable that is compatible with the selected controller board 

Download, read, and carefully follow each step in the appropriate MAXREFES117# quick 

Start Guide: 

MAXREFDES117# mbed Quick Start Guide 

MAXREFDES117# Arduino Quick Start Guide 

 



Lab Measurements 
Equipment used: 

• MAX32600MBED# 

• Adafruit Flora 

• Adafruit BlueFruit 

• Polar H7 Bluetooth Smart Heart RateHeart-Rate Sensor 

• Android tablet 

Figure 3 and Figure 4 show how the MAXREFDES117 calculated heart rate compared to 

the Polar H7 chest strap. The data in Figure 3 were taken while the person was sitting still 

for 20 minutes. And the data in Figure 4 were taken while the person was walking at a 

normal speed for 20 minutes. 

 

Figure 3. For sedentary test, over 99% of the mbed + MAXREFDES117# heart heart-rate 

data are less than 5 beats/min delta from the Polar H7 chest strap. 



 

Figure 4. For moving test, over 92% of the Arduino + MAXREFDES117# heart- rate data are 

less than 10 beats/min delta from the Polar H7 chest strap. 

Quick Start 
Required equipment: 

• Windows PC with a USB port 

• MAXREFDES117# board 

• 5 cables that can be used to connect the MAXREFDES117# with the controller board 

• One of the supported mbed or Arduino controller boards listed above 

• One USB cable that is compatible with the selected controller board 

Download, read, and carefully follow each step in the appropriate MAXREFDES117# quick 

Start Guide: 

MAXREFDES117# mbed Quick Start Guide 

Quick Start: Required equipment: 

• Windows PC with a USB port 

• MAXREFDES117# board 

• 5 pieces of wires to connect the MAXREFDES117# to the controller board 

• One of the three supported controller boards (Maxim Integrated MAX32600MBED#, 

Freescale FRDM-KL25Z, or Freescale FRDM-K64F) 

• One micro USB cable (for MAX32600MBED# and FRDM-K64F) 

• One mini USB cable (for FRDM-KL25Z) Procedure 



The reference design is fully assembled and tested. Follow the steps below to verify board 

operation: 

1. Create an account on http://developer.mbed.org to use their online compiler. 

2. Import the demo program from https://developer.mbed.org/teams/Maxim- 

Integrated/code/RD117_MBED/ 

3. Connect the MAXREFDES117 to the controller board: For MAX32600MBED# 

MAX32600MBED# port MAXREFDES117 port 

P26 SDL SDA 

P27 SCL SCL 

P20 SCK RX INT 

3.3V VIN 

GND GND 

4. For FRDM-K64F 

FRDM-K64F port MAXREFDES117 port 

E25 SDA 

E24 SCL 

D1 INT 

P3V3 VIN 

GND GND 

  



5. For FRDM-KL25Z 

FRDM-KL25Z port MAXREFDES117 port 

E0 SDA 

E1 SCL 

D1 INT 

3.3V VIN 

GND GND 

6. Connect the controller board to the PC with a USB cable. 

7. In the MBED compiler, click the button at the upper right hand corner to select the 

appropriate controller board. 

8. Compile and download the resulting binary to your mbed platform. 

9. Press the Upload menu item in the Sketch menu to upload the firmware to the Flora 

board. 

10. Open Hyperterminal or a similar terminal program on the PC. Find the appropriate 

COM port and configure the connection for 115200, 8-N-1 with no flow control. 

11. Put a finger on top of the U1 on the MAXREFDES117#, contact with an earlobe is 

also sufficient. Constant pressure yields the best result. 

12. Press any key on the terminal program and the system will start the conversion. 

13. From left to right, the first two column shows the data for red and IR LED receiver. 

Third and fifth columns show the calculated heart rate and SpO2 values. And the 

fourth and sixth columns show the validities of the heart rate and SpO2 calculations. 

MAXREFDES117# Arduino Quick Start Guide 

 
 

 



Quick Start 
Required equipment: 

• Windows PC with a USB port 

• MAXREFDES117# board 

• 5 cables with grabber clips on both ends. 

• One of the three supported controller boards (Adafruit Flora, Lilypad USB, or Arduino 

UNO board) 

• One micro USB cable (for Lilipad or Flora) 

• One A to B USB cable (for Arduino UNO) Procedure 

The reference design is fully assembled and tested. Follow the steps below to verify board 

operation: 

1. If Arduino IDE is not installed on the PC follow the getting started guide to install the 

Arduino IDE on the PC. 

2. If Adafruit Flora board is selected as the controller board: 

o Follow the Adafruit Windows Driver installation guide to install the driver. 

o Follow the "Adafruit Arduino IDE setup guide" to install the Arduino IDE and 

support files for Adafruit Flora board. 

3. Download the source code RD117_ARDUINO.zip file and unzip it in a desired 

location. 

4. Double click the RD117_ARDUINO.ino to open the project in Arduino IDE. 

5. Connect the MAXREFDES117 to the controller board: For Flora 

Flora port MAXREFDES117 port 

SDA SDA 

SCL SCL 

D10 INT 

3.3V VIN 

GND GND 



6. For Lilypad USB 

Lilypad USB port MAXREFDES117 port 

2 SDA 

3 SCL 

10 INT 

+ VIN 

- GND 

7. For Arduino UNO 

Arduino UNO port MAXREFDES117 port 

SDA SDA 

SCL SCL 

10 INT 

3.3V VIN 

GND GND 

8. Connect the controller board to the PC with a USB cable. 

9. In the Arduino IDE, click on the Tools menu and make sure the appropriate board is 

selected. 

10. Select the proper communication port in the Tools menu. 

11. Press the Upload menu item in the Sketch menu to upload the firmware to the Flora 

board. 



12. Open Hyperterminal or a similar terminal program on the PC. Find the appropriate 

COM port and configure the connection for 115200, 8-N-1 with no flow control. 

13. Put a finger on top of the U1 on the MAXREFDES117#, contact with an earlobe is 

also sufficient. Constant pressure yields the best result. 

14. Press any key on the terminal program and the system will start the conversion. 

 

15. From left to right, the first two column shows the data for red and IR LED receiver. 

Third and fifth columns show the calculated heart rate and SpO2 values. And the 

fourth and sixth columns show the validities of the heart rate and SpO2 calculations. 

All Design Files 

Download All Design Files 

Hardware Files:  

Schematic 

Bill of Materials (BOM) 

PCB Layout 

PCB Fab Package 

PCB CAD (PADS 9.0) 

Firmware Files:  

Arduino Platform 

mbed Platform 

 



X-ON Electronics
 
Largest Supplier of Electrical and Electronic Components
 
Click to view similar products for Multiple Function Sensor Development Tools category:
 
Click to view products by  Maxim manufacturer:  
 
Other Similar products are found below :  

RD-KL25-AGMP01  PTC-04-DB-ACT  PTC-04-DB-FL  FRDM-K22F-SA9500  EV_ICM-20649  MULTI-SENSE-GEVB  FRDM-STBC-

SA9500  BRKT-STBC-SA9500  3397  STEVAL-MKIT01V1  EVAL-CN0411-ARDZ  SEN0004  KT-TVOC-200-TB200A  KT-NmHc-200-

TB200A  SEN0344  PIM520  PIM518  PIM519  PIM510  103030375  ZSSC4132KIT  ADIS16505-3/PCBZ  SEN-16794  PIM502  SEN0359 

4829  EV26Q64A  EVAL-AD7746RDZ  EVAL-AD7746HDZ  AS7022-EVALKIT  RTK0ESXB10C00001BJ  MAX30134EVSYS#  EV-CBM-

PIONEER1-1Z  EVAL-ADPD188BIZ-S2  EVAL-ADCM-1  EVAL-CN0507-ARDZ  SI118X-KIT  ALTEHTG2SMIP  EVAL-CN0533-EBZ 

MIKROE-4305  MAX30101WING#  MIKROE-4192  MIKROE-4049  OB1203SD-U-EVK  OB1203SD-BT-EVK  MIKROE-4037  101990644 

MIKROE-4267  MIKROE-4265  MIKROE-4330  

https://www.x-on.com.au/category/embedded-solutions/engineering-tools/sensor-development-tools/multiple-function-sensor-development-tools
https://www.x-on.com.au/manufacturer/maxim
https://www.x-on.com.au/mpn/nxp/rdkl25agmp01
https://www.x-on.com.au/mpn/melexis/ptc04dbact
https://www.x-on.com.au/mpn/melexis/ptc04dbfl
https://www.x-on.com.au/mpn/nxp/frdmk22fsa9500
https://www.x-on.com.au/mpn/tdkinvensense/ev_icm20649
https://www.x-on.com.au/mpn/onsemiconductor/multisensegevb
https://www.x-on.com.au/mpn/nxp/frdmstbcsa9500
https://www.x-on.com.au/mpn/nxp/frdmstbcsa9500
https://www.x-on.com.au/mpn/nxp/brktstbcsa9500
https://www.x-on.com.au/mpn/adafruit/3397
https://www.x-on.com.au/mpn/stmicroelectronics/stevalmkit01v1
https://www.x-on.com.au/mpn/analogdevices/evalcn0411ardz
https://www.x-on.com.au/mpn/dfrobot/sen0004
https://www.x-on.com.au/mpn/airwat/kttvoc200tb200a
https://www.x-on.com.au/mpn/airwat/ktnmhc200tb200a
https://www.x-on.com.au/mpn/airwat/ktnmhc200tb200a
https://www.x-on.com.au/mpn/dfrobot/sen0344
https://www.x-on.com.au/mpn/pimoroni/pim520
https://www.x-on.com.au/mpn/pimoroni/pim518
https://www.x-on.com.au/mpn/pimoroni/pim519
https://www.x-on.com.au/mpn/pimoroni/pim510
https://www.x-on.com.au/mpn/seeedstudio/103030375
https://www.x-on.com.au/mpn/renesas/zssc4132kit
https://www.x-on.com.au/mpn/analogdevices/adis165053pcbz
https://www.x-on.com.au/mpn/sparkfun/sen16794
https://www.x-on.com.au/mpn/pimoroni/pim502
https://www.x-on.com.au/mpn/dfrobot/sen0359
https://www.x-on.com.au/mpn/adafruit/4829
https://www.x-on.com.au/mpn/microchip/ev26q64a
https://www.x-on.com.au/mpn/analogdevices/evalad7746rdz
https://www.x-on.com.au/mpn/analogdevices/evalad7746hdz
https://www.x-on.com.au/mpn/ams/as7022evalkit
https://www.x-on.com.au/mpn/renesas/rtk0esxb10c00001bj
https://www.x-on.com.au/mpn/maxim/max30134evsys
https://www.x-on.com.au/mpn/analogdevices/evcbmpioneer11z
https://www.x-on.com.au/mpn/analogdevices/evcbmpioneer11z
https://www.x-on.com.au/mpn/analogdevices/evaladpd188bizs2
https://www.x-on.com.au/mpn/analogdevices/evaladcm1
https://www.x-on.com.au/mpn/analogdevices/evalcn0507ardz
https://www.x-on.com.au/mpn/siliconlabs/si118xkit
https://www.x-on.com.au/mpn/mpression/altehtg2smip
https://www.x-on.com.au/mpn/analogdevices/evalcn0533ebz
https://www.x-on.com.au/mpn/mikroe/mikroe4305
https://www.x-on.com.au/mpn/maxim/max30101wing
https://www.x-on.com.au/mpn/mikroe/mikroe4192
https://www.x-on.com.au/mpn/mikroe/mikroe4049
https://www.x-on.com.au/mpn/renesas/ob1203sduevk
https://www.x-on.com.au/mpn/renesas/ob1203sdbtevk
https://www.x-on.com.au/mpn/mikroe/mikroe4037
https://www.x-on.com.au/mpn/seeedstudio/101990644
https://www.x-on.com.au/mpn/mikroe/mikroe4267
https://www.x-on.com.au/mpn/mikroe/mikroe4265
https://www.x-on.com.au/mpn/mikroe/mikroe4330

